This is a published version of the following:


Kim Nayyer
1999

This review was originally published in Canadian Law Libraries, available online through:

http://www.heinonline.org/HOL/Page?handle=hein.journals/callb24&id=224&collection=journals&index=journals/callb

Citation for this paper:


Introduction

In late 1998 Corel released the complete version of its WordPerfect Suite 8, Legal Edition with Dragon NaturallySpeaking. The components of the Suite comprise not only the office applications familiar to users of Suite 7, but also several legal tools and Dragon's very intriguing voice recognition software. The core application, WordPerfect 8, has undergone considerable change since Version 7 and even more change since Version 6. Some of the layout changes and substantive changes in WordPerfect 8 are reviewed here, as are some other useful features introduced in earlier versions and retained in WordPerfect 8. Highlights of some of the other Suite 8 components are also reviewed. Space does not permit a detailed review of the office applications, but they are discussed briefly in a review of the integration of the Suite components. The review begins with a brief overview of the installation process and the technical requirements of the product.

Technical requirements and installation

The system requirements for the Suite are somewhat demanding, largely because of the resource requirements of NaturallySpeaking. For the user who chooses not to use the voice recognition software, the system requirements are standard for office applications. The Suite runs on a Windows 95/98 or NT 4.0 operating system. The hardware requirements are a PC with a minimum 133 MHz Pentium level processor, 48 MB of RAM for machines running Windows 95 and 64 MB of RAM for Windows NT, a 2X CD-ROM drive, and 180 MB of hard disk space for a typical installation. NaturallySpeaking also requires a 16-bit sound card or comparable built-in audio. The user is given the option of performing a full install or a custom install, whereby specific applications and "bonus" items can be left out of the installation. I opted for the full install, using a standalone PC with a Pentium II processor, 128 MB of RAM, and a 32X CD-ROM drive. The installation process was pain-free and rather quicker than I expected given the two CDs contained in the product.

As noted, the minimum system requirements are reduced considerably for users who choose not to install NaturallySpeaking or who buy the Version of the Suite without voice recognition software. In that case, a PC with a 486 66 MHz processor, 8 MB of RAM, a 2X CD-ROM, and 120 MB of disk space will do. Corel offers "upgrade" pricing for users of not only earlier WordPerfect editions, but also any word processor, spreadsheet or office suite from Microsoft, Lotus, Novell or Borland. This offer provides a significant reduction in price - over $300, or almost 50% of the retail price, at the time of writing.

WordPerfect 8 features

Although some useful new features have been added, many of the changes from Version 7 to WordPerfect 8 are cosmetic. The cynical among us might suggest that the purpose of the new interface design is to make WordPerfect look more like its major competitor; the diplomatic might suggest that the purpose is to ease the transition for converts. Users of WordPerfect 6, however, will see significant changes in this product. The transition is not likely to be difficult for users comfortable with earlier Windows-based WordPerfect versions.

Some of the substantive changes to WordPerfect 8 are useful and interesting enhancements, whereas others are a little disappointing and, perhaps, steps backward when compared with earlier editions. Stalwart WordPerfect for Windows users might find it a little disconcerting that many of the tools and functions are accessed differently in WordPerfect 8 than in previous versions and, in fact, follow a layout similar to that in Microsoft Word. For example, the menu items have changed somewhat. Gone are the Table and Graphics menus, which now are in the Insert menu or on their own toolbars, in the same manner as when MS Word 6.0 upgraded to Word97. Document properties are no longer accessed through the Document menu item. Properties is now its own item in the File menu. The Document item deals with formatting and multiple document features.

Also of note is the addition of a Page Setup menu item, located in both the Format and File menus, which combines some formatting functions with some print options. Other terminology that has changed in WordPerfect 8 includes the former Initial Style, now Document Style, and Initial Font, now Default Font. In all of these cases, the methods and functions are essentially the same, the changes are in layout, appearance, and terminology.

Features new to WordPerfect 8 include the PerfectExpert, which offers some context-sensitive tips and assistance while creating a WordPerfect document from start to finish, using formatting, editing, and visual elements. Another is Prompt-
As-You-Go, which displays spelling and thesaurus suggestions as words are typed. A useful addition to WordPerfect 8 is the font face viewer, which allows the user to see exactly what each of the many fonts included with the Suite will look like simply by scrolling along a drop-down menu.

There are also some rather disappointing aspects of WordPerfect 8, and these generally relate to navigation. The automatic whole word selection that occurs when the mouse is used for selecting text can be awkward, and often results in the unintentional selection or failed selection of a word when several words are selected. Also, double-clicking to select a word often results in selection of an entire paragraph, which can be unfortunate if the user is not careful in observing what is selected and deleted. Deletion brings to mind an unexpected revision of what is selected and deleted. As in Microsoft Word, the user must choose Cut to remove selected text with the mouse, which can be inconvenient if the user wishes to retain existing text in the clipboard.

Earlier features retained in WordPerfect 8 include the useful Shadow Cursor, which can be turned on or off. When turned on it allows the user to know where the insertion point will be located when the mouse is clicked, including in white space in a document. Also retained is the QuickFormat feature, which allows instant application of formatting features from one place in the document to other selected text. Also retained is the HTML and SGML publishing capability under the File menu.

It should be mentioned that the ever-popular Reveal Codes, central to the application's structure, of course remains in WordPerfect 8. As with earlier WordPerfect versions, Reveal Codes is available in the Styles editor as well as in the main document. Many users will find the presence of this feature in both of these contexts invaluable in formatting, creating styles, and locating and correcting the frustrating oddities that are bound to occur from time to time. The WordPerfect 8 Styles editor also retains the QuickStyles function. QuickStyles enables the user to create or edit a Style simply by copying formatting already applied to text.

WordPerfect 8's legal components include HotDocs 4.1, which is essentially a library of document templates providing content as well as structure for sample document types. The tool uses dialog boxes to simplify the creation of often used, fairly standard documents. Another useful component is the Pleading Expert Designer, which responds to user input about layout and page formatting to create default settings for litigation document cover sheets. A companion tool is the Pleading Expert Filler, which allows the user to identify the parties, court, and other information for particular files, so the information can be easily entered in the templates created with the Pleading Expert Designer. Also of note is the inclusion of the spelling lexicon of Black's Law Dictionary among the word lists in WordPerfect's Spell Checker. Another West tool, less useful for Canadian users, is CiteLink, which can automatically create links between citations to American cases in a document and the location of the text of that case on West's Web site.

Other Suite components

Dragon NaturallySpeaking - Packaged with WordPerfect Suite 8, Legal Edition is Dragon NaturallySpeaking, a handy and very effective voice recognition tool. The user must invest time training NaturallySpeaking for his or her speech, but even the initial training session allows fairly accurate word processing by dictation. Tips are included with the software to maximize its effectiveness, and when these and the general use guidelines are followed NaturallySpeaking's performance improves with each use.

The software contains an extensive vocabulary for both legal and non-legal terms. Because predefined words are used, spelling errors do not occur. As well, the software generally recognizes the correct choice from among similar sounding words because word choice is based on the context of the sentence or phrase dictated. The corollary of this is that recognition generally is better when the user dictates longer sentences or phrases. NaturallySpeaking enables not only voice text entry of alphanumeric characters and symbols but also some formatting, editing, navigation, and correction by voice. In fact, the composition of much of this text was done using NaturallySpeaking, and very little manual correction was required.

As noted, NaturallySpeaking is a heavy consumer of system resources. Although I did not experience any crashes, performance can slow down if other resource-demanding applications are running simultaneously. Users with older systems or limited RAM or virtual memory will have to be wary of this.

Amicus Attorney - A much-anticipated tool included with the Legal Edition is Amicus Attorney, an excellent office, file, home business, or personal management tool. Like other scheduling and personal management tools, Amicus Attorney contains a calendar and daily planner, enabling the user to schedule appointments and receive reminders, and a detailed contacts file with up to three different profiles for each contact listed. The product allows the user to create client files and matters on which time can be entered by customizable codes and time intervals. Other useful features include the work timer, which the user can switch on and off to keep track of the time spent on any particular task. This time can be translated automatically to billable amounts based on a billing rate the user can set and post to a client file where invoices are stored until they are billed. Amicus Attorney also reminds the user about outstanding time entries or charges, and can be linked to the user's accounting package for posting of time entries.

1999 Canadian Law Libraries/Bibliothèques de droit canadiennes, Vol. 24, No. 5 213
Suite integration

WordPerfect Suite 8, Legal Edition is a complete office suite, offering the standard combination of applications most users will need to use: a word processing package, WordPerfect; a spreadsheet application, Quattro Pro; a database application, Paradox; a presentation package, Presentations, and a personal information management and communication program in Amicus Attorney. Also included are Barista for Web publishing and the Envoy viewer which supports various graphics formats. One of the practical advantages of a software suite is the format compatibility and portability of documents among the various applications in the suite. Suite 8 offers these among its word processing, spreadsheet, database, and presentation applications. For example, Paradox can be used for building databases upon which the user can draw when creating mail merge documents in WordPerfect or when analysing data using Quattro Pro. One of the drawbacks of a suite is the converse of this. For a user who prefers, for example, MS Excel to Quattro Pro, some of the compatibility advantages will be lost if the preferred application is used.

Kim Nayer, LLB MLIS Student, University of Alberta Calgary, AB


While all law libraries and related legal personnel now have computers, it is still handy to have a few old paper reference tools, particularly phone books and directories, for the days Hydro is working on your neighbourhood lines or the corporate LAN through which you access the ubiquitous and informative Internet has decided to slow down to a crawl. One of these old standards is the Canada Legal Directory. The 1999 version, which is also the 88th edition of this directory, has all the usual handy information to put you in touch with most of the legal community either by phone, fax, e-mail or snail mail.

The directory is divided into several sections. The first one, the professional cards section, gives some quick insights into the firms that advertise there. The e-mail directory of lawyers grows bigger every year and also contains web site addresses. The Government of Canada section contains federal government information as well as federal boards, agencies and commissions. The bulk of the book is broken into jurisdictions, with provinces being listed alphabetically. Each provincial section starts with provincial government blue pages, which include law societies, law schools and related services. Following these pages are the lists of law firms subdivided by city groupings and within each city, by firm. Towards the end there is a special section for corporate in-house counsel. The final index is an alphabetical list of all lawyers mentioned by last name.

This is a substantial, heavy volume. The layout is clear. The information packed in it is equally voluminous. Fortunately, due to judicious choice of typefaces and careful attention to layout and spacing, it remains easy to scan and read.

If you don't have this in your library (which you should), make friends with the closest legal secretary, who will undoubtedly have a standing order for this book. Older editions are useful for a year or so, but in these days of rapid change with mergers, new area codes, etc., they will only be guides and not true reference books. A current copy is recommended for all law libraries.

Franki Elliott
Book Review Editor
Canadian Law Libraries


As the editors promise in their preface, this book has only just begun. Assembled as a loose-leaf service in three-ring binder format, the editors plan to update the text but the time schedule is not clear to the reader. The content is the product of various practitioners: Darrel H. Pearson, Brian S. Goldstein and Laurence M. Friedman, Allison Taylor and Jeffrey Goodman, Ronald Michael Green, Julie Lee, as well as the editors. In spite of this pot-pourri of authors, the text is uniform, consistent and well thought out. The various chapters are held together by a table of contents, table of cases, table of abbreviations and index. Many of these types of legal compilations suffer from lack of cohesion, however these editors have succeeded in providing the necessary linkages to make this a single and therefore useful text. The subjects covered include immigration to and from Canada, on a temporary or permanent basis. Sufficient detail as to visas, tax, customs and employment standards gives the reader a good handle on what to expect.

With the adoption of agreements such as NAFTA, travel, trade and trouble will increase between the U.S. and Canada. Firms will hire, re-locate and fire employees whose residence may be in the other country. Towards that end, practitioners will be increasingly asked to render advice in the area of com-